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Users and Developers from Around the World
Gather To Learn Vital Q&A Survival Techniques
and Preview Coming Q&A Successor Product

BY Wednesday, January 10—two days before the big event—organizers
of The International Q&A Users Conference 2001 were beginning to
worry. A powerful Pacific storm—the worst in years—had just

smashed into southern California, pummeling the state with gale force
winds and record rainfall. Widespread flooding, power outages and even
rare West Coast tornado watches were making national headlines. Airport
traffic delays were increasing. Freeways were turning into underwater
parking lots. And the National Weather Service was forecasting that the
storm would continue into the weekend.

But by Friday, January 12 the tempest subsided, and what poured into
Southern California instead were  more than 150 Q&A devotees from as far
away as Europe, South Africa, Asia, Australia and New Zealand—the
largest gathering of Q&A users and developers ever. And as it turned out,
not one of them was the least regretful that they made the long journey.

Topic One—Surviving with Q&A
The theme of the conference was Q&A and the Future.…Expanding the
Functionality of Q&A Now and Migrating to Lantica Database Products in
the Future. Conference host, Quick Answer publisher Tom Marcellus, opened
the event Saturday morning by welcoming everyone in the packed hall.
Laughter could be heard downstairs in the hotel lobby as Tom treated
attendees to excerpts from several “Q&A Support Calls From Hell” that his
company had received in recent months.

Bill Halpern
Professional Computer Technology Associates (PCTA) co-owner and Quick
Answer @Help column editor Bill Halpern gave the first presentation. In his
90-minute wide-screen presentation on surviving with Q&A in light of

Q&A Conference Packs House.
150 Attend from 11 Countries

today’s new operating systems and PCs,
Bill covered a wide range of vital issues
that are increasingly affecting all Q&A
users: How to set up Q&A to run
optimally in Windows 98, 2000, NT and
ME. Important system settings you’d
better not ignore. The correct way to
configure your Q&A desktop Shortcut
and properties. How to coax essential
Expanded Memory from a computer that
refuses to provide it. Which new
computers to avoid purchasing. The
options you have for solving the “too

Not an empty seat in the place. Conference attendees watch demonstrations on the big
screen. You can too as all presentations were professionally videotaped .

BONUS 16-page
Q&A Conference Issue!

VIDEOS—page 12
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From THE INTERNATIONAL Q&A USERS CONFERENCE 2001

9 Hours of Q&A Solutions!

The Best-Attended  Q&A User Event Ever!

Digitally Recorded and
Mastered for Sharpest Picture

SPECIAL BONUS!
Videotape sets include the
Conference CD attendees received
with presenters’ handouts, demo
databases & other files

Bill Halpern  Q&A in All O/S’s
Everything you need to know about getting
Q&A to run perfectly on any PC. Professional
Computer Technology Associates (PCTA) co-
owner and Quick Answer @Help column editor
Bill Halpern gives an expert 90-minute wide-
screen presentation on surviving with Q&A in
in today’s new operating systems and PCs. He
covers a wide range of vital issues that are
increasingly affecting all Q&A users: How to set

Tom Marcellus  Q&A Data on the Web
The Quick Answer publisher Tom Marcellus gives a 75-
minute presentation on “Five Ways to Get Your Q&A Data
on a Web Site.” With the explosion of Internet access in
recent years, the Web has become the low-cost medium for
wide-area data dissemination in companies looking for a
competitive edge in sales and service. Watch as Tom works
with actual Q&A databases, demonstrating easy, practical

Erika Yoxall   Sophisticated Reports
Many Q&A users with departmental or company-wide responsibilities
rely on their workhorse Q&A databases to help them store, retrieve and
manipulate their vital information. But when it comes to summarizing
and commiting that information to paper, Q&A’s Report module too
often just can’t produce the kind of output—or look—needed to
communicate the data in the clearest, most effective way. Q&A for DOS’
inability to take advantage of the advanced features found in today’s
printers only compounds the problem. An attractive solution expertly

ways to output Q&A data to “Web-ready”-formatted files
that can be immediately uploaded to a Web server at any
interval for instantaneous access by anyone anywhere.
Tom shows that Q&A has the tools to do it. You just have
to know where they are and how to use them. Several of
Tom’s demo databases along with the Web files he uses
during his presentation are on the Conference CD.

up Q&A to run optimally in Windows 98, 2000, NT and ME.  System
settings you’d better not ignore. The correct way to configure your Q&A
Shortcut and properties. How to coax essential Expanded Memory from
computers that don’t come with it. Which new computers to avoid
purchasing.  Options for resolving the “too large hard drive partition”
problem and why you put your data at risk by neglecting this issue. Bill
covers all these issues and more in graphic detail. He then talks on
resolving database corruption problems with Q&A 5.0, and offers some
much-welcomed suggestions on on how to handle common printing
problems when using Q&A for DOS with troublesome printers.

demonstrated by Erika Yoxall of Hammer Data
Systems involves designing the report in Microsoft
Access’ powerful graphical report writer, then
clicking on a button to flow in the data from the
Q&A database. Q&A data. Access container.  The
result?—gorgeous, professional-looking report
output enhanced with pictures, colors, lines, boxes
and shading. Erika’s demo files on the Conference
CD help simplify setup.

(Continues next page...)Photocopy Order Form, fill it out, then fax or mail it to us.
Or order online at www.quickanswer.com/qavideos.htm

See the Coming Q&A
Successor Product

In Action!

☞

VHS
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VIDEOSQ&A Conference 2001
continued...

Jeff Noreman   Network Essentials
“Houston, We Have a Problem—It’s the Network
Again.” Whether you’re sharing your databases
over a network now or plan to in the future, this
is one “high-tech” morass most of us would
rather not have to confront. So we call in “The
Network Guy”—a guy like Jeff Noreman of
Nexus Unlimited. As Jeff points out early to a
round of hearty laughter—where computer

networks are concerned: if it ain’t broke, it will be! And it’s laughter and
learning for the next 90 minutes. Where do you begin when you want to
network two or more PCs? What do you need to do in and with Q&A to

safely and efficiently share your files? Peer-to-peer vs. standalone
server—which is best for you? Should you use Windows built-in
networking or buy a networking software package? How do you setup
network resource sharing for printers, Internet connections and the like?
Home and home/office networks—how are these different? How do you
choose a reliable network interface card? Cabling vs. telephone and
electrical line networks—what are the advantages and disadvantages of
these? Jeff covers all the essentials, including networking traps to avoid,
interspersed with a host of troubleshooting tips. You’ll be treated to a
clinic on practical networking by the guy the Q&A experts call when “It’s
the Network Again!”

John Dow   Third-Party Q&A Utilities
Nobody knows what really lives inside a Q&A database
better than John Dow. That’s because during the past few
years John has developed a small army of powerful utility
programs that do everything from analyzing and repairing
Q&A database corruption, to extracting data, changing
multiple passwords in a single pass, and copying report
designs from one database to another. In his presentation,

John demos a number of his most popular utility programs
for Q&A, showing their valuable diagnostic and time-saving
capabilities. Judging by the periodic flurry of note-taking, for
many attendees the solutions to their recurring Q&A
problems were right there on the screen in one or more of
John’s demos. And they went home with the same demo
files on their conference CDs.

Alec Mulvey   Merging Q&A Data with MS Word
Regular Quick Answer contributor, Alec Mulvey of Keyword Training in
the UK, proves, as in past Q&A Bashes, an exceptional treat. Alec’s
unflappable British wit, coupled with his wide-ranging expertise as a
long-time Q&A developer, trainer, and computer applications consultant,
has the audience in stitches as he gives a very well received big-screen
demonstration on integrating Q&A data with Microsoft Word. A barrier
for many Q&A for DOS users has long been the lack of a truly WYSIWYG
word processor in which to design and print graphically-enhanced

merge letters, mailing labels, forms and the like.
And then there’s the problem of long-outdated
Q&A printer driver support. Most people today
have Microsoft Word on their computers, but
many don’t know how (or even if ) they can
merge their Q&A data with Word documents.
Alec’s detailed, step-by-step demonstration
proves how easy it really is.

You’ve known for some months that a group of Q&A developers,
consultants and power users formed a company to develop a new 21st

century Q&A-compatible database manager as a successor to Q&A.  But
who are the people doing it? What is this new product going to look
like? What will it do for me that the Q&A I’m now using can’t do? How
really “Q&A-compatible” will it be? Now you can find out!

Tom Marcellus opens the presentation by describing the chain of
events beginning in 1998 that led to the
decision to develop an all new Q&A-
compatible successor product.

Bill Halpern then takes the podium to tell
you  all about the new company, Lantica
Software, LLC, which has been working on
the new product for 18 months. Bill describes
the company’s objectives with the product—
code-named “Sesame”—explaining  that its
first and foremost mission is to provide a solid and sensible upgrade
path—a powerful 32-bit solution—for Q&A users running virtually any
operating system now and to come—Windows 95/98, NT, ME, 2000, and
even Linux/Unix! He then introduces the founding members and
principals of the new company.

Bill goes on to describe and show the product’s state-of-the-art
client-server architecture, making it fast, efficient, and natively
networkable, whether the server is down the hall, on the same computer

as the client (for standalone use), or 5,000 miles away on a Web server!
“Faster than Q&A,” is how Bill answers a  question about speed.
Bill shows how the new product accommodates the same

programming syntax as Q&A and describes how your Q&A database
programming will convert in the new product right along with the form
design, reports, field formatting and other specs.

What’s more, the new product will feature a host of powerful new
programming capabilities, such as true
variables that don’t require “temporary” fields
to store interim calculations and loops that
don’t need separate fields with Q&A-like
Gosub/Return statements in them.

Sesame development team leaders
Erika Yoxall and Mark Lasersohn then
continue the demonstration. They take you
on an extended hands-on tour of the Alpha

version of “Sesame.” You’ll see up close its familiar Q&A-like menu
system and form-based interface. You’ll see databases with records
being added and updated, including a form with an embedded subform
that demonstrates the product’s relational capabilities. You’ll also
discover how you can search a “Sesame” database exactly the same way
you’d search a Q&A database. Same retrieval parameters; same syntax;
same results.  Nothing new to learn! This video will have you cheering
right along with the audience!

Q&A-Successor Product Unveiled—See It in Action!

Quick Answer Subscribers
Get 15% Off the Tape Set Price
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save that macro file to disk so that the macro file on disk is
the same as the one in memory.

If you now press Alt-F2 or click the right mouse
button or select “Run Macro” from the Macro Menu, you
should get the message, “No macros have been defined.”

The next step is to create a new macro file to contain
the macros you’re going to record.  You can create a file
within Q&A before you start recording macros:

1. Press Shift-F2 again for the macro menu.

2. Select  S - Save Macros

The pathname Q&A proposes is the Q&A program files
directory. Type the filename TEST.MAC and press Enter.
(See the sidebar.) The dialog will close and that’s it.

Press Alt-F2 again. “No macros have been defined”
again. That’s correct. We’ve got a macro file, but an empty
one with no macros yet. Time for our first macro.

If you use Q&A’s Write word processor at all, then
you will find that a macro to display the recently-used file
list will come in handy. What’s that? You didn’t know
Q&A Write has a recently-used file list? Shame on you!

Escape back to the main menu, then follow these
steps:

1. Press Shift-F2 to display the Macro Menu.

2. Select D - Define Macro. Q&A prompts you to “Type the
macro identifier, or press Enter for none.” For example:
Alt-A, Alt-B, and so forth. We’ll use Alt-G.

3. Hold down the Alt key and press G. You will now see a
small rectangle flashing alternately Red and Yellow in
the extreme bottom-right corner of the Q&A screen. If
you are running Q&A in a Window, you will see just a
solid yellow rectangle that does not flash. You can
switch Q&A between full-screen and window mode by
pressing Alt-Enter at any time, even in the middle of
recording a macro—Q&A doesn’t care. From here on
out, Q&A will record all your keystrokes—even your
typos and subsequent backspaces to erase the mistake.
Even the Escape key. The only way to end recording a
macro is to press Shift-F2 again.

4. Press W to select Write from the Main menu.

5. Press T to select Type/Edit from the Write menu. You
should be at a blank document screen.

6. Press F8 for the Options Menu.

7. Press D for Documents from the Options menu.

Voilá: your most recently-used documents!

Macros. . . cont’d from page 11

It’s here you want to stop the macro, with the
recently-used file list on screen, so you can select which
document to open.

Press Shift-F2 again to stop recording. The Macro
Options dialog is displayed. (See Figure 3.) Here is where
you can give the macro a proper name. Always name your
macros—it’s a zero-cost option.

The name Q&A proposes will be <altg>. Never just
accept this! Rather, overtype it with a descriptive name for
the macro. The macro name can be up to 31 characters and
can include spaces, mixed capitalisation, and some (but
not all) non-alphanumeric characters, which it’s wise to
avoid anyway. Name your macro “Recent Documents,”
and press F10.

Q&A now invites you to save the macro file. At this
point, the macro file in memory has one more macro than
its counterpart file that’s stored on disk. In our example,
we’re using TEST.MAC. Press Enter or F10 to save the
macro file with your new macro.

You now have one macro that you can run from the
Q&A Main menu by pressing Alt-G.  Try it.

Naming Macro Files
Don’t use QAMACRO.ASC as a macro file name. Use

anything else. The way that macros in Q&A work is that

when Q&A starts up it looks for a macro file. If you don’t

specify a particular one (you’ll learn how to do this shortly),

then it looks for one named QAMACRO.ASC in the Q&A

program files directory. If it doesn’t find this file either, then

you’ll have no macros you can run. But—here’s the catch—

if you then start recording macros, Q&A will create a new

QAMACRO.ASC file and store them there. This is why I say

use anything but QAMACRO.ASC as a macro filename. It’s

so easy to get a proliferation of such files, all with the same

name, and be confused about which is the right one,

particularly on a network. Generally, you want one unique

macro file, so it’s better to name it explicitly.

Q&A accepts anything as a macro filename and

doesn’t care what the file extension is. You could even use

“AUTOEXEC.BAT” as your macro file name—but don’t!! I use

the file extension “.MAC” for all macro files, so my working

macro file is named KEYWORD.MAC.

Figure 3.  Naming the macro
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Adding macros to the Main menu
Now, there’s a possible snag. Suppose you’re not at the
Main menu? Open the File menu first, then press Alt-G.
The macro doesn’t work; it tries to Post from a file named
“D”.  That’s the problem with Q&A macros—they’re
dumb. It’s vital to bear in mind the context of macros, and
any conditions which must be met when they are run.

For example, you don’t want to record a macro that
Mass Updates a database on a network and then goes on
to perform other actions, without considering what the
consequences might be if another user is in that database,
locking it and preventing the macro from continuing. Very
often macros can be made “safe” by building in an “N”
for “No” here, or an Esc there, to cover these
circumstances. Always rehearse macros first (so that the
file you’re creating already exists and you get the “do you
want to overwrite...” message), and test them under all
expected conditions.

As for context, the safest thing by far is to control how
macros are started. I avoid keystroke assignments
wherever possible, limiting their use to safe macros that
are unlikely to do damage, or to where you are forced to
use them such as Alternate Menu items. Speaking of
which: seeing we only want our Alt-G macro to start from
the Main menu, let’s add it to Q&A’s Main menu. To do
this, from the Main menu, select Utilities / Set Alternate
Programs.

For Alternate Program 1 use type Alt G (with or
without a space, capitalisation is irrelevant) and for the
Menu selection type Recent Docs. It isn’t possible to type
“Recent Documents” due to the rather restrictive 13-
character limit. Press F10.

Now your Q&A Main menu should have two
columns. But there’s another snag. Pressing “R” now runs
the alternate program, and this conflicts with “R—
Report.” (You’ll need to use the arrow keys to select
Report.)  Q&A always uses the first letter of the “Menu
Selection” text as a keystroke shortcut for the menu
item—without checking for conflicts.  To resolve this,
return to the Alternate Programs menu and change the
menu selection to “Get Document” or “Last Docs” or any
other text where the first letter does not conflict with a
Q&A Main menu item.

Any macro run from the Alternate Programs menu
must have an Alt-something key identifier. The Alt letter
does not need to be the same as the first letter of the menu
selection, so “L - Last Docs” can run the “Alt G” macro.
(See Figure 4.)

Activating a Macro File
The next time you start Q&A, the default macro file,
QAMACRO.ASC, will be loaded. You can load a different
macro file into memory by pressing Shift-F2, selecting G -
Get Macros, and specifying an alternative macro file. To
load a specific macro file every time Q&A starts, you need
to add a start-up switch to the Q&A command line. To do
this, right-click on the shortcut icon that you use to start

Q&A, select Properties / Program / Cmd Line, and after
QA.COM add a space then type -AL[macro filename].  For
example:

C:\QA5\QA.COM -ALTEST.MAC

If your local hard disk or server partition is greater
than 2G, then you should be using Lesspace and starting
Q&A with a batch file. In this case, you’d have to modify
the batch file. Just add the same start-up switch to the
batch file’s QA.COM line.

To continue, why don’t you create some more macros
to open your favourite database(s) in Search/Update
mode and Add Data mode? These can likewise be put on
the Main menu. You’re limited to six additional Alternate
Programs, but next month I’ll show you how to easily
create your own custom menus, so you can add limitless
macros. I’ll also show you how to how to create a “Pop-
up” custom menu.

Alec Mulvey is a founding member and official of Lantica Software, LLC

and owns Keyword Training & Consultancy in Ascot, near London,

England. Alec has been building Q&A applications and training clients

for 11 years. Keyword Training is the UK distributor for the International

English edition of Q&A and John Dow’s Utilities. Fax +44-1344-884-111,

alec@keywordtraining.com, www.keywordtraining.com.

Figure 4. The Q&A Main menu with one Alternate Program

Warning!
 You should be more than hesitant about using the F3

(Delete) key in any macro unless you are very sure it will

be safe under all conditions. Also be very cautious about

using numbers in macros. You might not know this, but

you can select Q&A menu items by typing the menu item

number. So, for example, on the Main menu “1” is File, “2” is

Report, “3” is Write, and so forth. If a macro can’t do what it

is intended to do, it will bash away at menus. Letters or

numbers that do nothing will be ignored and any that do

something will be invoked. It is alarming to consider that

the sequence “16 F10 F10 1” will remove all records from

the last database used! Please—if you want to try this—

do so on a copy of a database!
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@Help. . . cont’d from page 7

<#32:
If ((#30 = “Y”) and (#2<12/31/2000)) Then #32 =
(#31*.0775);
If (#30 = “Y”) and (#2>1/1/2001) Then #32 = (#31*.0750);
If #30 = “N” Then #32 = 0.00

I can plug any percentage into the first statement and it
works. But the conditions don’t seem to work.

Marc

Close, but no cigar. Your program is inconsistent in some
of the parentheses and missing some critical quote marks.
Try this and it should work:

<#32:
If #30=”Y” and #2<=”12/31/2000" Then #32=(#31*.0775);
If #30=”Y” and #2>”12/31/2000" Then #32=(#31*.0750);
If #30=”N” Then #32=0

Dates specified in programming must be surrounded by
quotes to prevent Q&A from interpreting them
arithmetically.

Bill Halpern is co-owner of Professional Computer Technology Associates

(PCTA) in Newtown, Pennsylvania. He is also the President and CEO of

Lantica Software, LLC. 215-598-8440, www.pcta-usa.com, email

pcta@comcat.com.

Updated Q&A ZipCode
Database Now Available
After failing to find an up-to-date  downloadable ZipCode file

on the USPS’s Web site, we wrote to them to complain. Back

came the database we were looking for in Microsoft Access

(yuck!) format. So we dumped the data out of it (42,713

records) and into a nice little Q&A 4.0 database that you can

now download from the “Freebies” page at

www.quickanswer.com and use in any version of Q&A.

The database contains a Speedy ZipCode field, along

with fields for the City and State, so if you rig it up right as a

lookup file, you’ll be able to type in the Zip in an address

record and have Q&A auto-fill the City and State fields. A

program to do this might look like this one in the Zip field:

>XLookup("ZIPCODES", Zip, "Zip", "City", City,
"State", State)

Here, Zip, City and State are field names in both  databases

and the XLookup executes on leaving the Zip field (after the

ZipCode has been entered).


